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General Notes on Navigation

The screen is divided into four areas: the menu to
the left [1] with navigation buttons and the page
number, which you can type in to jump to a specific
side.

The content list is at the top [2], divided into
chapters. The glossary is at the bottom [4], with key
words and phrases linked throughout the help files.
You can swap the glossary for an index list, as
preferred. Simply click a keyword in either case to
link straight through to a relevant help page.

The middle frame shows the current document [3].

There are two methods to navigate the help files:

Interactive

or

Consecutive

Select Navigation Method

There are two methods to navigate AV32 's help
files:

1. Interactive Navigation.
This allows you to control which texts you view by
hovering the mouse over the relevant hotspots in
the illustrations.

2. Consecutive Navigation.
This mode leads you sequentially through each
help page. All available details are shown one after
the other. Click the 'Next page' button (right arrow)
in the left navigation panel [1] to move one step
onwards.

1 2

3

4

Important Note
AV32 is machine-independent software. It offers a multitude of functions, some of which may not be supported by
your machine. This online help document describes the general functions of the program using illustration which
- dependent on your machine, post-processor and purchased options - may vary from the display on your
system. The continuous development of AV32 can also cause differences between the screenshots shown, and
what is shown on your workstation. Please first compare the revision number of your help documentation to that
of your software, and check our Website to see if there is a newer version available.
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Start / Exit the Program, Navigate the Program.

AV32 is a shell containing integrated modules for
management, construction and production of sheet
metal parts. Calculating your parts' values carries
particular worth and is made easy by the program's
Item-oriented calculation method, which allows you
to total various combinations of Parts, Articles and
Cost Centers into accurate estimates for a
complete job.
Cut parts can be nested on to stock sheets using
standard machine values, allowing you to quickly
discover production costs per Item. A typical
estimate calculation process might look like this:

Enter the machines' Cost Centers (as foundation
settings).
Enter the customer details (see Online help for the
customer form in AV32 ).
Create a Part in the Parts Bin (see Online help for
the Parts Bin in AV32 ).
Enter all Articles in the Articles Bin (see Online help
for the Articles Bin in AV32 ).
Enter the Cost Centers (see Online help for Cost
Centers in AV32 ).
Create a Project (see Online help for the Project
form in AV32 ).
Combine the Project's various Items into
Assemblies (see Online help for creating
Assemblies in AV32 ).

You can of course utilize each step individually.
You can use a technology module to add
technology data relevant to your machine to your
drawings.
To ensure correct operation of the software, you
must begin by setting it up to your workstation's
requirements.

This is AV32 's homepage. Click the 'Home' button
from any other module to return to this page.

Click the IBE logo to visit IBE Software GmbH's
website.
This requires an active internet connection.

Exit the program by clicking [File][Exit].

Important Note
You must allocate material groups to your
machines to avoid errors during your parts'
production. Material groups are given properties
which relate to their technical possibilities. These
settings also help avoid damage to your machines.
You can work on the material groups by clicking
[Edit] [Material and Machine Data Management].
The help page for this item is in the Admin's help
pages.

1

2



AV32

Rev. 1.5 Date: 2018-5-7Page: 3

1
You can access each module individually while
working. The following modules are the most
important when calculating your parts' values:

'Master Data' contains information about your
regular customers, your Parts Bin, sheet stock, and
extra data such as Cost Centers.
'Orders' allows you to enter customer orders into the
system.
Complete estimates can be combined into Projects
and managed under 'Projects'.

2

The 'Home' button always brings you back to this page.
The menu panel offers some useful navigation options. 'Exit' is under the [File] menu.
To make basic program settings or to optimize the program for the calculation in the editing, click
[Options].
You can find information 'About' the program under [Help].

21

To make settings for individual users, click [Individual Settings]. This menu allows you to make setings
for each individual user, eg. allowing a user access only to the estimate forms to give trimmed-down
access as required.

For basic settings which will affect all users, click [Common Settings].
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Program Settings

This screen allows you to make the basic settings
for your estimates. These settings concern:

Quantity units.

Formulae for material estimates.

Sheet sizes and labels for standard sheets to allow
provisional nesting, insuring accurate costings.

Cost Centers for machines to insure overheads are
costed accurately.

The available settings are also described in their
corresponding context help dialogs.Settings which should be applied to all users can

be made under [Options][Common Settings]. All
users on your network can thus be given the same
basic settings and conditions. You can find a
description of the functions in the Admin's help
pages.

1

1

The top tab row links to the program's varyious modules. The second tab row is context sensitive,
containing options as shown here:

Quantity Units: 'Config', 'Master Data', 'Article'
Formulae for Material Estimates: 'Material'
Sheet Sizes: 'Material'
Cost Centers: 'Machines', 'Calculation'
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11
Select 'Config', 'Master Data', 'Article'

This frame contains settings for the quantity units
used in your estimates. Set the units as required.
Right-click the list to open a menu allowing editing or
input of new entries.

12

Select 'Material'.

Material management is an important part of AV32 . Material groups are used to define properties of
materials, and allow accurate estimation of total costs. For more details, view the relevant Admin help
page.
Weights and prices of materials are calculated based on the formulae contained in these cells. Presets
for the calculations are made in the Material and Technology management table.
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13

Select 'Calculation'.

Set the standard sheet sizes for estimates here. Adjust the entries to your requirements. Right-click in
the list to open a menu with options for editing and adding entries. Presets for the calculations are
made in the Material management table.

14

Select 'Machines', 'Calculation'.

A Cost Center can be allocated to each machine in order to accurately represent the overhead costs
associated to it. You can add programming costs here too. For help entering setup times, see the
Online help for Cost Centers in AV32.
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15

The densities and prices of materials are held ready for your calculations in the 'Material and
Technology management' table.

Important for the calculation of weights. The density and the price can be specified in each case in
different units. Put a formula under Common [Settings],[Material] in what units price and weight should
be calculated.

Enter 'Sheet-articles' in the calculation as a basis if different prices for different thicknesses are used.
You can enter prices individually in the article list. Once you have set a price for calculation for an
article selected here, the price specified here is ignored. Is no panel selected item or its price 0, the
value entered here is used as a price.

For more information see the relevant Admin help page.
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Managing Calculation Items

The following list shows the individual Items you
can use in your calculations.

Parts
Articles
Cost Centers

Select the screen in the navigation panel to the left
[1]. The screens allow you to list the existing Items
and select them for use. New Items can be added
or existing Items edited under Record Navigation.

Individually prices can be managed for sheets.
Assign a sheet to an article and maintain the price
on thus generated 'Sheet-article'. Generate a
necessary number of standard sheets for your
estimation with sheet-articles and assign a priority
number to each sheet-article. This allows you to
organize the sheets for selection.
Select the menu item 'Edit', 'Sheet Prices' to adjust
the prices for estimation for all sheets with a
priority.

Once all Items are in the database, you can
combine them to make a Project. A Project may
contain any number of individually-calculable
assemblies made up of combinations of Items.

This chapter illustrates the individual Items which
can be used to construct a Project.

1
2 3

4
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1
The navigation panel offers direct access to the various screens. A new Project can be
bound to one customer; in this case you should enter the customer details first.
Following Items can be entered into the database when creating estimates:

Parts (Cut parts)
Articles (Bought components/Sheet-article)
Sheets
Cost Centers

11
See the relevant chapter for detailed help on
entering your customers' details .
Entering your customer data is important if you plan
to print your offer and include the customer's address
and the name of your contact.
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12
See the relevant chapter for help entering Parts' data
into your Parts Bin.
The parts form has a 'Estimation' frame in the
top-right corner, where you can enter more detailed
information for the price calculation.

13
See the relevant chapter for help entering Articles'
data into your Articles Bin.
An article may also be a sheet, assigned to an article.
For a so generated 'sheet-article', an individual price
can be set for each sheet. You can adapt these
prices quickly for your estimation. Select the menu
item 'Edit', 'Sheet prices' in the header to get the
appropriate dialog.
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16
You can allocate an article in the articles-archive to a
sheet in the sheets-archive. Click the button '<Article'
in the header and you go to the 'Sheet-articles'. Here
you can set an individual price for a sheet. For
assignment, an article is created with the same item
number as the sheet number. If the item number
already exists, you must change this, or assign a free
number to the sheet manually.

It is important that you enter a priority for the
estimation of a sheet with a sheet-article. Only
sheets with a priority are listed for estimation.

See the relevant chapter 'Article' in the online help to
AV32 for entering an article.

14
See the relevant chapter for help entering Cost
Center data.
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15
Enter the required number of parts in this frame. Click 'Calculation' to enter
the Calculation Grid Object (KGO) editor to edit the back-office formulae and
variables.

4
You can adjust the price for estimation for all sheets, which
have a sheet article and a priority > 0. Click on 'Sheet prices'
and a dialogue opens with the list of sheets.

41

You access this dialog via the menu item 'Edit', 'Sheet prices' in the header. All sheets will be listed,
which are associated with a sheet-article and a priority > 0. You can put the prices up to date and adjust



AV32

Rev. 1.5 Date: 2018-5-7Page: 13

them for estimation in the table. If the price is 0, the price of the material management is used for
estimation.

2
You can list the current database
entries from each of the program's
forms. Select 'List' in the bottom tab
panel and click 'All' in the header
panel. Select the required Item in the
list and switch to the 'Fields' tab.

3
You can print your work from any of the program's forms. Click 'Print' to open the form
editor, which offers wide-ranging options for formating your printed sheets - more
details can be found in the relevant help chapter.
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Presets for Parts.

The table [1] contains an Object in each row (KGO
or Calculation Grid Object, named in column 0)
with its data in the corresponding cells in columns 1
through 12. The cells are managed according to
rules defined in the 'KGO Editor'.
You can access the 'KGO Editor' through the
[Options] menu in the header panel.

You can see the Part in the right frame [2] with its
technical data as calculated from the entries in the
Calculation Grid.

The calculation data are held in a table as
individually editable Objects, enabling the
complete calculation of all parts. The Objects
(KGO, Calculation Grid Objects) are each defined
in one row of the table. The individual cells can be
edited to your requirements using the 'KGO Editor'
.

Access this window from the 'Parts Bin'
('Estimate').

1

2

11
Access the 'KGO Editor' from the [Options] menu.
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1

This table contains all Calculation Grid Objects (KGOs) for the Part. The cells in columns 1 through 12
are managed by set rules (formulae) which can be edited in the KGO Editor. You can also expand the
table with your own values.
Columns 9 through 11 allow you to set pricing steps. You can set different sized order quantities in the
top row.
Access the KGO Editor through the [Options] menu in the header panel.

The cutting data required for a calculation are calculated by executing a virtual cutting process of the
selected parts on a predefined standard sheet. Sheet s election, time and quantity calculation are set
using variables in the 'Cutting / Material' tab.

Individual areas can be folded or unfolded, in order to increase clarity in the table. The lines
respectively indicate the results of the closed area. This feature requires an entry for an area in the
customer-specific KGO; usually this is the 'USER.KGO'.
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12
To calculate the cutting time for a Part,
the Part must first be processed in a
virtual cutting routine. This tab allows
you to select a standard sheet and the
nesting method, and make settings for
time calculations.
A dialog opens in which all
'Sheet-articles' are listed if you click on
'Sheet selection'. Only sheets are listed
with a predefined priority. If you have
defined standard sheets, you can always
reuse these sheets.

Enter the parts distance and the number
of torches in the middle region and on
the tab 'Nest', the number of the parts to
be nested.

You can enter time-corrections in the
'Time calculation' frame and set cutting
speeds on the tab 'Input'.

15

This list shows you all articles of 'Sheet-articles', which have the same values in material and
thickness, which the workpiece requires for manufacturing.

13
Enter the number of parts required in the 'Nest' tab. Click
'Nest' to open the 'Pricing Nesting' dialog, which contains
functions equivalent to true-shape nesting. For more
information on true-shape nesting, see the relevant Online
help page.
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14
Enter the cutting speed and lead-in time here to obtain an
accurate final estimate.

2
This frame shows the cut part currently being worked along
with its technical data. The data are calculated from the
cutting data and calculation presets for the material group.
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The KGO Editor.

The Objects in the Calculation Grid are defined one
in each row and listed in the object list [1].
Columns 0 through 12 are populated with the
corresponding Object's details for each Object /
row in the table [3]. The list shows the selected
Object.

The KGO Editor is a tool for entering and
maintaining the rules and formulae required by the
Calculation Grid.

1 2

3

4

1
This list shows all of your Project's Objects. To edit an Object's properties,
highlight it in the list, and click the relevant cell in the table [3].



AV32

Rev. 1.5 Date: 2018-5-7Page: 19

2

This table contains rules and formulae for variables which are not used in the cutting process, but are of
value when creating estimates. You can, for example, include data on outsourced work here.

3

This table contains the detailed values for each Calculation Object. Column 0 of the Calculations Grid
contains the Object's identifier, while columns 1 through 12 contain the relevant information.
Mark the cell to be edited. The content can be edited in the input field below the table. If the cell is a
selection rather than input value (eg. text direction or color) then a selection list will be shown below the
table.

Remember to save any changes you make, or they will be lost. Click the 'Save' icon in the header
panel.

The rows contain following properties:

ACCESS - Access rights for a cell (editability).
VALUE - Shows the cell's value, eg. hourly rate.
FORMAT - Describes the display format when outputting the value.
CALC - Formula for calculation of the value, where required.
SUM - Used to generate column sums.
TEXTALIG - Sets the text alignment within a field.
NOACCESS - Allows a different-colored display for fields which may not be accessed.
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4

This frame offers selection lists corresponding to the cell's content. In this case the selection made was
'Access' and these are the available options. Use the buttons to the right to apply the setting to multiple
cells. Always consider any unwelcome side-effects when making changes to multiple cells!
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Projects as Containers.

A project's positions can consist of all types of
Items. The Project Wizard will help you to
assemble your projects from Parts , Articles and
Cost Centers. You can even include sub-Projects
in your final Project.

To edit the content of a Project, select 'Content'
from the left navigation panel [1]. You can 'List' the
content [2] and select relevant Items for
processing. You can add new Items easily using
the Project Wizard.

To print your offer, click 'Print' in the header panel.

A Project creates a working frame for calculating
your estimate. Projects can include any Items (cut
parts (Parts), bought components (Articles) and
machine costs (Cost Centers)) and also
sub-Projects eg. to represent sub-assemblies, and
outsourcing costs. The Project Wizard will help you
populate the positions when creating your Projects.

1 2 3

4

1
Click 'Content' from the Project form to access this screen.



AV32

Rev. 1.5 Page: 22Date: 2018-5-7

2
This list shows the contents of your Project. Select a
position to see more detailed information on how its
price was calculated [3].

3
Prices can either be calculated
dynamically based on database
tables, or entered here as fixed
concrete values. Switch to the 'Fixed
Price' tab to enter a fixed price.
Remember to mark the checkbox to
the right if you wish to use a fixed
price.

31
If you wish to enter a fixed cost for a Project position [2], then
enter it in this input field and mark the checkbox to the right of
the 'Calculate Price' frame.

4
Click the arrow button at the bottom of the left navigation panel to return to this screen from
any of the Items' screens.
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Articles
An Article is any object which belongs to a Project.

Article Number 10
General 7
Name 10
Price 10
Quantities 10
Sheet-articles 7

Assemblies
Assembled Parts, which consist of various Items.

Content 21
General 20
Introduction 21
Items 7
Project Wizard 20

Calculation-Nesting
Nest your Parts in order to calculate the production costs.

General 13
Part Offset 16
Parts Quantity 16
Selection 16
Torch Quantity 16

Calculation
Calculating the Prices for an assembly.

Angles 15
Area 17
Calculation Rate 15
Contour length 17
Cutting Speed 17
Definitions 19
Drilling 15
General 7
Graduation 15
Grid Objects 18
Hourly Rate TE 11
Hourly Rate TG 11
Hourly Rate TR 11
Hourly Rate 15
Introduction 12
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KGO Editor 12
Lead-in Time 17
Load/Unload 15
Markings 19
Material 15
Multi Torch Operation 15
Nesting 16
Objects 18
Outsourcing 19
Part Counts 16
Part Offset 16
Parts Quantity 12
Presets 13
Price 11
Priming 15
Priority 16
Production 15
Programming Costs 15
Sand Blasting 15
Setup Costs 18
Sheet Formats 10
Sheet Setup Time 11
Sheet Size 13
Stagger Price 15
Table 19
Time Calculation 17
Times 15
Tool Setup Time 11
Torch Quantity 16
Weight 17
Welding 15

Cost Centers
Calculate Production costs using data on each specific machine.

Entry 11
Introduction 9
Settings 6

Customers
Information about the people who order sheet metal parts from you.

Entry 9
General 7

Form Editor
Editor to format printed pages individually as required by your business.

Starting point 13
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Item
An Item is a concrete thing like a part, article, or other thing.

Articles 10
Cost Centers 11
Lists 13
Overview 7
Parts 10
Print 13
Purchased Parts 10
Selection 9

Machines
Cutting Machines using different cutting methods for Production of metal parts.

Calculation 6
Cost Centers 3
Introduction 3

Material
Sheets from varying materials, from which your parts will be cut.

Formulae 5
Introduction 6
Material Groups 7
Price 7
Thicknesses 7

Parts
Workpieces as individual components of an assembly.

Entry 10
General 7

Projects
A Project is a collection of assemblies for the Calculation of a price estimate, or a parts list.

Assemblies 20
Calculate 22
Components 20
Content 22
Cost Centers 21
Fixed Price 22
General 20
Introduction 21
Prices 22
Project Wizard 20
Unit Price 22
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Settings
Basic Settings for your Calculation.

Calculate Automatically 6
Common 3
Cost Centers 6
Formulae 5
General 3
Material Groups 7
Part Offset 6
Parts 17
Prices 7
Programming Costs 6
Quantity Units 5
Rules 15
Sheet Sizes 6
Standard Sheets 6
Theme Selection 4
Thicknesses 7

Sheets
The basis for nesting your parts.

Formats 16
General 13
Prices 12
Selection 6
Setup Time 11
Standard Sizes 13

Start
Order Management - first steps.

Common Settings 3
Customers 9
General 1
Home Page 3

Tables
Tabeles with values for the Calculation.

Cell Access 19
Cell Color 19
Cell Formats 19
Cell Formulae 19
Cells 19
General 17
KGO Editor 17
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Table 19
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A Angles (Calculation) 15
Area (Calculation) 17
Article Number (Articles) 10
Articles (Item) 10
Assemblies (Projects) 20

C Calculate (Projects) 22
Calculate Automatically (Settings) 6
Calculation (Machines) 6
Calculation Rate (Calculation) 15
Cell Access (Tables) 19
Cell Color (Tables) 19
Cell Formats (Tables) 19
Cell Formulae (Tables) 19
Cells (Tables) 19
Common (Settings) 3
Common Settings (Start) 3
Components (Projects) 20
Content (Assemblies) 21
Content (Projects) 22
Contour length (Calculation) 17
Cost Centers (Projects) 21
Cost Centers (Machines) 3
Cost Centers (Settings) 6
Cost Centers (Item) 11
Customers (Start) 9
Cutting Speed (Calculation) 17

D Definitions (Calculation) 19
Drilling (Calculation) 15

E Entry (Cost Centers) 11
Entry (Customers) 9
Entry (Parts) 10

F Fixed Price (Projects) 22
Formats (Sheets) 16
Formulae (Material) 5
Formulae (Settings) 5

G General (Assemblies) 20
General (Sheets) 13
General (Parts) 7
General (Projects) 20
General (Start) 1
General (Articles) 7
General (Calculation) 7
General (Customers) 7
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General (Calculation-Nesting) 13
General (Settings) 3
General (Tables) 17
Graduation (Calculation) 15
Grid Objects (Calculation) 18

H Home Page (Start) 3
Hourly Rate (Calculation) 15
Hourly Rate TE (Calculation) 11
Hourly Rate TG (Calculation) 11
Hourly Rate TR (Calculation) 11

I Introduction (Projects) 21
Introduction (Material) 6
Introduction (Assemblies) 21
Introduction (Calculation) 12
Introduction (Machines) 3
Introduction (Cost Centers) 9
Items (Assemblies) 7

K KGO Editor (Calculation) 12
KGO Editor (Tables) 17

L Lead-in Time (Calculation) 17
Lists (Item) 13
Load/Unload (Calculation) 15

M Markings (Calculation) 19
Material (Calculation) 15
Material Groups (Settings) 7
Material Groups (Material) 7
Multi Torch Operation (Calculation) 15

N Name (Articles) 10
Nesting (Calculation) 16

O Objects (Calculation) 18
Outsourcing (Calculation) 19
Overview (Item) 7

P Part Counts (Calculation) 16
Part Offset (Calculation) 16
Part Offset (Settings) 6
Part Offset (Calculation-Nesting) 16
Parts (Item) 10
Parts (Settings) 17
Parts Quantity (Calculation) 12
Parts Quantity (Calculation-Nesting) 16
Presets (Calculation) 13
Price (Material) 7
Price (Calculation) 11
Price (Articles) 10
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Prices (Sheets) 12
Prices (Projects) 22
Prices (Settings) 7
Priming (Calculation) 15
Print (Item) 13
Priority (Calculation) 16
Production (Calculation) 15
Programming Costs (Calculation) 15
Programming Costs (Settings) 6
Project Wizard (Assemblies) 20
Project Wizard (Projects) 20
Purchased Parts (Item) 10

Q Quantities (Articles) 10
Quantity Units (Settings) 5

R Rules (Settings) 15

S Sand Blasting (Calculation) 15
Selection (Sheets) 6
Selection (Calculation-Nesting) 16
Selection (Item) 9
Settings (Cost Centers) 6
Setup Costs (Calculation) 18
Setup Time (Sheets) 11
Sheet Formats (Calculation) 10
Sheet Setup Time (Calculation) 11
Sheet Size (Calculation) 13
Sheet Sizes (Settings) 6
Sheet-articles (Articles) 7
Stagger Price (Calculation) 15
Standard Sheets (Settings) 6
Standard Sizes (Sheets) 13
Starting point (Form Editor) 13

T Table (Calculation) 19
Table (Tables) 19
Theme Selection (Settings) 4
Thicknesses (Settings) 7
Thicknesses (Material) 7
Time Calculation (Calculation) 17
Times (Calculation) 15
Tool Setup Time (Calculation) 11
Torch Quantity (Calculation-Nesting) 16
Torch Quantity (Calculation) 16

U Unit Price (Projects) 22

W Weight (Calculation) 17
Welding (Calculation) 15
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